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1 Introduction

Du 8 avril au 14 juin 2019 j’ai effectué mon stage 8 EDF DIPDE (Division de I’'Ingénierie du Parc, de
la Déconstruction et de I’Environnement), dans la cellule C3D (Centre de Compétences en Cyber-
sécurité de la DPNT - Direction du Parc Nucléaire et Thermique).

Mon sujet de stage a été adapté par rapport a celui indiqué sur la fiche mission pour des raisons de
sécurité informatiques (informations confidentielles), ce que je précise dans la partie ‘Missions et
Objectifs’.

Pendant cette période, j’ai principalement préparé et documenté des systémes qui seront utilisés pour
des audits de cyber-sécurité.

J’ai eu 2 missions principales : le cassage de mots de passe, et 1’étude de transmissions en fréquence
radio (écoute, rejeu, modification de signal, ...).

2 Présentation de ’entreprise

2.1 EDF

EDF est actuellement une société anonyme intégrée comprenant principalement les branches en propre
ou au travers de filiales : production (EDF DPNT, HYDRO, E.N.), distribution (RTE, ENEDIS) et
commercialisation (EDF Commerce) d’¢électricité. Les parties constructions neuves de production
(EDF DIPNN) et recherche et développement (EDF R.&D.) sont aussi des composantes importantes
d’EDF.

La branche production-ingénierie dans laquelle j’ai réalisé mon stage fait partie de la branche DPNT a
laguelle appartient la DIPDE.

La cellule « C3D », entité de la DPNT, est hébergée & la DIPDE Marseille.
2.1.1 La DIPDE

2.1.1.1 Organisation

La DIPDE (environ 1900 personnes) est plus particulierement en charge de toute la maintenance et
I’entretien de I’ensemble de la partie nucléaire des centrales nucléaires frangaises en fonctionnement,
dit le « Parc Nucléaire », soit 58 tranches nucléaires 900, 1300 et 1450 MWe, réparties sur 19 sites sur
toute la France (les CNPE — Centre Nucléaire de Production d’Eléctricité).

La DIPDE est basée a Marseille (environ 1200 personnes) pour les services supports (administratifs,
RH, logistique), les études de I’1lot nucléaire (DEIN), les approvisionnements/achats de prestations et
travaux (PCO — Performance COntractuelle / Contr6le de Gestion Opérationnel) et les responsables
Projets et travaux (DPP — Département Performance des Projets, et DR — Département Réalisation).

Une antenne de la DIPDE est sur Lyon (environ 180 personnes), pour les études d’environnement et
de deconstruction (DEED), et des agents relais de la DIPDE (environ 520 personnes) sont sur chaque
site au travers des Equipes Communes (DIPDE + DPN-CNPE) afin de suivre les travaux de
maintenance.

Des organigrammes (EDF et DIPDE) sont joints en Annexe a et Annexe b.
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2.1.1.2 Activités

La DIPDE étudie et applique des modifications pour optimiser les performances des centrales et
s’assurer de leur streté.

Depuis 2014, un programme industriel, le ‘Grand Carénage’, vise la prolongation de la durée de
fonctionnement des réacteurs pour permettre au Parc d’atteindre ses objectifs de production en toute
shreté. 80% des activités de la DIPDE sont dédiés a ce programme, principalement les projets de
déconstruction des centrales nucléaires définitivement mises a ’arrét (9 réacteurs) ainsi que la
construction des nouvelles installations nécessaires a la gestion des déchets.

2.1.2 C3D

La cellule « C3D » travaille pour I’ensemble du Parc nucléaire (DPNT) : ilot nucléaire (cceur et circuit
primaire), ilot conventionnel (partie de la centrale nucléaire non directement liée au réacteur (circuits
d’eau secondaires et tertiaires, transformation de la vapeur en électricité par la turbine, etc.)), parc
existant et nouveaux paliers, activités de déconstruction, outils d’ingénierie et systémes informatisés
de la protection de site. Elle travaille aussi en collaboration avec la cellule C21 (Contréle Commande
et Informatique Industrielle) qui dispose de son coté de simulateurs numériques de centrales nucléaires.
Ces simulateurs permettant de tester la conformité et sécurité des programmes avant diffusion sur les
sites en exploitation.

Photo 1 - aIIe de commande de la centrale de Chooz (Ardennes). ©Alexandre Sargos/EDF Mediathéque

2.1.2.1 Doctrine

La cellule C3D assure un suivi des doctrines et référentiels techniques opérationnels en participant aux
instances internationales de sécurité informatique du nucléaire et a 1’élaboration des normes ou guides
qu’elles produisent (AIEA, IEC...), puis en décline les principes dans la doctrine et les référentiels
d’EDF. Elle participe aussi aux échanges en matiére de sécurité informatique du nucléaire avec les
autorités nationales et émet un avis au projet et en COSIN (Comité Operationnel de la Sécurité
Informatique du Nucléaire).
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2.1.2.2 Projets

Elle est sollicitée sur divers projets pour y apporter un appui et une expertise, notamment dans la
définition des actions relatives a la sécurité informatique a mener au cours du projet, ’attribution des
systémes dans un degré de sécurité, I’expression des exigences de sécurité dans les spécifications
internes ou a destination des fournisseurs, 1’étude d’architecture en sécurité, la recherche de
vulnérabilités dans les logiciels et équipements, le conseil quant & la mise en place de fonction de
sécurité ou la correction de vulnérabilités identifiées et la conduite du volet de sécurité des phases de
recette. Elle formule un avis indépendant sur la suffisance des dispositions prises en matiere de sécurité
informatique.

2.1.2.3 Vulnérabilités

Elle maintient I’infrastructure sécurisée de gestion des vulnérabilités de I’informatique du nucléaire et
participe a 1’analyse technique des avis de sécurité.

2.1.2.4 Cyber-surveillance et incidents

C3D définit les scénarios d’alerte a couvrir et les événements a remonter, congoit les outils de
surveillance des événements de cyber-sécurité afin de détecter le plus en amont possible tous les
incidents de sécurité informatique, appuie 1’exploitant pour 1’analyse des alertes cyber-sécurité et
définit les procédures élémentaires de traitement d’incident en cyber-sécurité.

2.1.2.5 Animation du domaine technique

Elle assure la gestion du Plan de Développement des Compétences dans le sous-domaine de la cyber-
sécurité et contribue au bilan de santé du domaine sur ce theme. Elle pilote aussi les projets de la R&D
en matiére de sécurité informatique du nucléaire.
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3 Contextualisation

3.1 Missions et objectif de stage

Ma mission initiale était : ‘aide la mise en place d’une infrastructure segmentée en différents réseaux
métiers comprenant un SAN, plusieurs DMZ, plusieurs coupe-feux...’. Aprés des échanges par mail
avec un membre de la cellule, une mission supplémentaire m’a été confiée : la mise en place d’un
cluster* de machines pour le craquage de mot de passe.

Mon responsable en entreprise, Jean-Hugues ZORIO n’étant pas disponible pendant deux semaines au
début de mon stage, c’est la personne qui m’a confié la mission de craquage de mots de passe qui m’a
supervisé (pendant cette période).

Au milieu de la durée du stage, ma mission initiale liée au réseau a €té remplacée pour des raisons de
confidentialités par 1’étude d’outils d’analyse des communications radio.

Le principal objectif de mes missions était d’apprendre a manipuler des logiciels qui seront utilisés par
la cellule C3D pour des audits de sécurité, et d’en constituer de la documentation d’utilisation. Dans
un cadre plus général, elles m’ont permis de voir et de comprendre comment casser et exploiter une
sécurité logique et physique.

3.2 Contexte technique

3.2.1 Craguage de mots de passe

3.2.1.1 Stockage des mots de passe

Les entreprises aussi grandes qu’EDF possédent un parc informatique trés complexe et trés grand, avec
un grand nombre d’utilisateurs.

A chaque groupe d’utilisateurs (administrateurs informatique, privilégiés ou utilisateurs simples, non
privilégiés) est attribué un mot de passe ainsi qu’une politique de mot de passe. Une politique de mot
de passe définit la taille, les caractéres autorisés et/ou obligatoires dans les mots de passe.
Des équipes de sécurité, tel C3D, peuvent étre sollicitées afin de tester la robustesse des mots de passe
et le respect des politiques.

En informatique, il est inacceptable de stocker des mots de passe ‘en clair’, c’est-a-dire lisibles
directement. On applique sur le mot de passe une fonction dite de ‘hachage’ qui va renvoyer une chaine
de caracteres, appelée ‘hash’ ou ‘empreinte’, mais unique pour chaque mot. Ces fonctions sont
irréversibles, et trées nombreuses. Les plus connues sont le LM, NTLM (utilisé par Windows), MD5,
SHA-1, SHA-256, SHA-512. Elles possédent toutes des caractéristiques différentes, et donc renvoient
des hash différents.

Par exemple, en MD5, le hash du mot ‘test’ est : 098f6bcd4621d373cadede832627b4f6

En SHA-1, c’est: a94a8feb5ccbl19ba61c4c0873d391e987982fbbd3

Eten NTLM : 0CB6948805F797BF2A82807973B89537

3.2.1.2 Concept de brute-force

Sachant que ces fonctions sont irréversibles, on peut se demander comment il est possible de retrouver
un mot de passe. Il existe plusieurs méthodes pour retrouver ce que contient un hash : 1’attaque par
force brute, I’attaque par dictionnaire, 1’utilisation de tables arc-en-ciel (communément appelées
Rainbow tables, cf. Documentation Rainbow tables dans les annexes)...

Le premier point commun entre ces méthodes est en général 1’utilisation du principe de collision : en
force brute, le principe universel est de tester toutes les possibilités jusqu’a tomber sur la bonne
combinaison. Pour des hash, le but est de comparer un hash dit de référence (de notre mot de passe)
avec plusieurs hash générés a partir de mots aléatoires. Ces mots aléatoires sont hachés en utilisant la
méme fonction de hachage que le hash de référence. S’ils correspondent, il y a ’collision’ et le mot de
passe est le mot aléatoire qui vient d’étre haché.
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Le second point commun est le besoin de puissance de calcul. Plus on a une grande puissance
disponible, plus le temps de cassage pour le brute-force sera réduit, et le temps de génération des tables
arc-en-ciel sera réduit.

Mais il est rare de craquer des mots de passe sans un minimum d’optimisation. Par exemple pour les
attaques par dictionnaires il est plus judicieux de prendre des listes de mots de passe les plus utilises
qu’une liste de mots générés aléatoirement. Lors de mes travaux sur les mots de passe j’ai utilisé
I’attaque par force brute et les tables arc-en-ciel.

3.2.2 Analyse de radio frequence

De nos jours, on a tendance a commander a distance, par radio fréquences, la plupart de nos appareils :
portails, lumieres, portieres de voiture, alarmes...

EDF a lancé depuis 2014 un projet de rénovation du parc nucléaire, le projet ‘Grand Carénage’. De
nombreux chantiers de construction et rénovation ont été lancés depuis ces années. Ces chantiers
doivent étre approuvés en termes de sécurité, donc la cellule C3D peut y étre sollicitée, comme
récemment, début Juin 2019. Pour préparer cet audit, j’ai transmis mes connaissances acquises au cours
de ma découverte des logiciels a Jean-Hugues ZORIO et un autre membre de C3D. Le principal objectif
a été d’essayer de faire du rejeu de signal.

Le principe du rejeu de signal est la technique la plus commune, la plus médiatisée (dans les films ou
séries) pour tester la sécurité ou le manque de sécurité d’un systéme commandé. Le rejeu décrit I’action
de renvoyer tel quel un signal capturé. Si le rejeu fonctionne sur un systéme, alors c’est que ce dernier
possede un codage des données ‘statique’, qui sert soit simplement a chiffrer le signal, soit a été décidé
par le constructeur.

Cependant, les systemes modernes sont dotés de codes plus complexes, a ce qu’il parait...

Le premier code ‘complexe’ qui empéche le rejeu est le code tournant. Une valeur ou plusieurs valeurs
dans le signal sont changées a chaque utilisation. C’est 1a qu’il devient nécessaire d’effectuer de la
rétro-ingénierie*. Dans mon cas, il est question de savoir comment sont agencées et transmises les
données d’un signal.

Apres avoir trouvé la ou les valeurs qui changent, il est courant d’essayer de brute forcer le signal,
¢’est-a-dire d’envoyer toutes les combinaisons possibles les unes a la suite des autres. Je n’ai pas eu
I’occasion de tester ¢a pendant ma mission.

Le piratage de radio fréquence, est devenu ‘a la mode’ (grace au « car hacking », le fait de pouvoir
ouvrir et démarrer une voiture informatiquement avec un émetteur et un pc) et il est donc nécessaire
de s’assurer de la sécurité du systéme.
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4 Travaux réalisés

4.1 Craquage de mots de passe

La cellule cyber-sécurité dans laquelle j’ai effectué mon stage a choisi d’exploiter la puissance de
calcul de carte graphique.

Le logiciel répondant le mieux a cette demande est Hashcat. Il existe un logiciel plus connu, plus ancien
nommé John The Ripper, mais sa derniere version (1.8 au moment ou j’ai débuté mes travaux) datait
de 2015, et ne permet pas d’exploiter le GPU*.

Hashcat se montre bien supérieur & John, supportant des technologies modernes de calcul exploitant le
GPU, plus de 200 types de hash, plusieurs types ‘d’attaques’.

La derniére version sortie de John The Ripper date du 14 mai 2019, mais nous ne nous sommes pas
plus penchés dessus, I’installation de la ‘station de craquage’ étant déja effectuée.

Le principal défaut des versions de Hashcat antérieures a la derniere sont qu’elles ne stockent pas les
mots testés (générés et hachés), ce qui implique que le logiciel re-calcule tous les mots déja calculés
lors d’une session précédente. Dans la derniere version, le logiciel possede une fonctionnalité nommée
« Brain » qui permet de stocker les mots déja haché pour soulager les calculs.

Le second logiciel que j’ai utilisé est Rainbowcrack. Il permet de générer et d’utiliser des tables arc-
en-ciel pour retrouver un mot de passe haché.

J’ai mis a disposition en annexe la documentation que j’ai réalisée sur ce logiciel, ainsi que des
explications sur le fonctionnement des tables arc-en-ciel (création, fonctionnement de la recherche)
dont les recherches m’ont beaucoup intéressé. L’origine de ces tables est 1’amélioration des compromis
temps-mémoire proposés par Martin Hellman vers 1980.

4.1.1 Force brute avec Hashcat

L’idée de base de C3D était de créer un cluster de machines pour craquer les mots de passe. Je disposais
donc d’une machine, et un alternant d’une autre possédant les mémes caractéristiques (carte graphique,
processeur, carte mere, mémoire RAM (Random Access Memory, mémoire vive permettant a un
appareil de stocker temporairement des informations a traiter)).

Pour éviter d’abimer le systéme avec des tests, et d’étre str de pouvoir les effectuer tranquillement,
j’ai da passer par une machine virtuelle*. Une fois sur ma VM (Virtual Machine), j’y ai installé Hashcat
pour commencer les essais.

Hashcat ne prend en charge que les appareils possédant I’ APT* OpenCL*. Pour vérifier la compatibilité

des composants de la machine, j’ai entré la commande hashcat --opencl-info dans un
terminal.
col@col-VirtualBox:~$ hashcat --opencl-info

hashcat (v4.0.1) starting...

No devices found/left.
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D’apres le résultat, le logiciel n’est pas parvenu a détecter une carte graphique ou un processeur.
Cependant, en Vérifiant directement sur la machine physique, Hashcat a détecté 2 composants
compatibles.

hashcat (v4.0.1) starting...
OpenCL Info:

Platform ID #1

Vendor T XXXX
Name T XXXX
Version : XXXX

Device ID #1

Type : GPU
Vendor ID T XXXX
Vendor T XXXX
Name T XXXX
Version T XXXX
Processor (s) ! XXXX
Clock T XXXX
Memory I OXXXX
OpenCL Version : xXxXxX
Driver Version : XXXX

Platform ID #2

Vendor T XXXX
Name T XXXX
Version : XXXX

Device ID #2

Type : CPU
Vendor ID T XXXX
Vendor T XXXX
Name . XXXX
Version T XXXX
Processor (s) ! XXXX
Clock T XXXX
Memory IOXXXX
OpenCL Version : xXXXX
Driver Version : XXXX

Le probléme vient de la machine virtuelle qui n’utilise pas complétement la carte graphique. J’ai
cherché comment il était possible de pallier a ce probléme, mais les résultats n’étaient pas concluant,
ou trop instables (mauvaise utilisation de la carte, trop peu de puissance).

Je suis donc passé directement sur la machine physique.

J’ai continué de faire des recherches sur la « clusterisation », les logiciels, les méthodes, puis au cours
d’une réunion, nous avons décidé d’abandonner 1’idée du cluster de machines, a cause d’une mise en
place longue et pas necessaire. Avec 1’équipe travaillant sur ce projet, nous avons décidé de rassembler
les deux cartes graphiques dans le méme boitier, pour au final posséder un seul ordinateur, et une
meilleure exploitation des GPU.
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J’ai effectué¢ une série de tests de craquage de mots de passe en brute force avec Hashcat pour
apprendre a manipuler le logiciel.

Par exemple pour le mot « test », haché avec du MD5, j’ai saisi la commande suivante :

hashcat -a 3 —-m 0 -o found.txt 098f6bcd4621d373caded4e832627b4£f6

L’option —a précise le mode d’attaque utilisé, ici 3 pour le brute force, 1’option —m précise la fonction
de hachage utilisée, le 0 correspond au MD35, I’option —0 précise le fichier dans lequel je récupére le
mot de passe craqué, et la suite de caracteres correspond au hash MD5 du mot.

Cependant, Hashcat utilise automatiquement un ‘masque’ par défaut si il n’est pas précisé. Pour le
logiciel, un masque sculpte le mot de passe. Il permet d’affecter a chacun des caractéres une plage de
valeurs (minuscules, majuscules, chiffres, caracteres spéciaux).

Le modele prédéfinit de Hashcat est trés génant car il ne balaye pas tous les mots de passe possibles :
Majuscule seulement au premier caractére, caractéres spéciaux présent a partir du 7e caractere...

Je me suis donc penché sur 1’utilisation des masques.
La documentation que j’ai réalisée est disponible en annexe (Documentation Hashcat), il est conseillé
d’y jeter un ceil pour clarifier les principes de masques qui constituent un élément important

d’optimisation.

Hashcat est un logiciel trés complet qui renvoie beaucoup de détails sur le cassage en cours :

Session..........: hashcat
Status...........: Running
Hash.Type........: shabl2crypt $6$, SHA512 (Unix)

Hash.Target......:
$6$0zVNEu2ckel $UE3dN2zJvjAdaHdWzI30H9sd7XrpliThbs5Si. . .%hJpD1

Time.Started.....: Tue Jun 11 15:36:37 2019 (50 secs)
Time.Estimated...: Tue Jun 11 20:15:25 2019 (4 hours, 37 mins)
Guess.Mask.......: 212121721 [4]

Guess.Charset....: -1 ?1?2d?u, -2 Undefined, -3 Undefined, -4
Undefined

Guess.Queue......: 1/4 (25.00%)

Speed.Dev.#1l.....: xxxx H/s (xxxxms)

Recovered........ : 0/1 (0.00%) Digests, 0/1 (0.00%) Salts
Progress.........: 32768/14776336 (0.22%)

Rejected......... : 0/32768 (0.00%)

Restore.Point....: 0/238328 (0.00%)

Candidates.#1....: mari -> mErc

HWMon.Dev.#1..... : Temp: 52c Fan: 25% Util: 99% Core: xxxx Mem:

XXXX Bus:xxxx

Ces informations sont envoyées a chaque « keyspace »*. Par exemple pour cet espace de possibilités,
il ya62*=14776 336 combinaisons. Il y a autant de keyspace que de caractéres spécifiés dans le
masque.

Des informations sur le temps estime et écoulé sont données mais elles correspondent seulement a la
keyspace en cours. Cela signifie qu’il faut attendre qu’Hashcat calcule toutes les possibilités de
I’ensemble actuel avant de connaitre le temps estimé du prochain, ce qui est tres embétant si on souhaite
seulement estimer le temps de cassage total. Quand on arrive sur des essais de plus de 10 caractéres,
avec une fonction de hachage complexe, cela peut prendre plusieurs jours (suivant la puissance
disponible).

J’ai remarqué cet ¢lément au cours de mes tests, et j’en ai discuté avec mon équipe pour savoir s’il était
possible d’obtenir le temps total final (donc le temps maximum que prendrait le cassage).
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N’ayant pas trouvé de réponses aupres des développeurs du logiciel ni sur des forums, j’ai pris
I’initiative de coder un script* bash* (cf. partie Script dans les annexes) qui renvoie le temps total
estime.

Pendant le traitement, le logiciel offre la possibilité d’effectuer plusieurs actions :

[s]tatus [plause [r]esume [b]ypass [c]checkpoint [gluit =>

‘Status’ affiche I’état actuel du calcul (les informations montrées plus haut), ‘pause’ arréte
momentanément le calcul jusqu’a la saisie de la lettre ‘r’, ‘bypass’ permet de sauter le calcul de la
keyspace actuelle et d’en afficher les informations juste apres, ‘checkpoint’ sert a créer un point de
restauration pour reprendre un autre moment la session de calcul, et ‘quit’ permet d’arréter totalement
le calcul.

Pour mon script, je me suis servi de la propriété de I’action bypass. Elle permet de récupérer les
informations de temps de calcul, tout en passant ces temps-la.

Il est juste de se dire que j’aurai simplement pu utiliser la vitesse de calcul en hash/s et le nombre de
possibilité pour calculer le temps total, mais la vitesse de calcul change pour chaque fonction de
hachage, et doit se stabiliser pendant les 10 premiéres secondes du calcul d’une keyspace.

C’est pour cela que mon script fait tourner en arriére-plan une commande Hashcat donnée en argument,
puis toutes les 30 secondes il lui envoie des demandes de bypass, jusqu’a la derniere qui arréte a chaque
fois le logiciel.

Pour exécuter la commande en arriére-plan j’ai utilisé le multiplexeur de terminaux ‘screen’. |l permet
d’exécuter plusieurs terminaux dans une console. L’avantage de cet outil est qu’il est possible de
rediriger le contenu de la fenétre créée en arriére-plan dans un fichier. J’ai exploité cette propriété pour
envoyer la sortie de la commande Hashcat dans un fichier et en récupérer a 1’aide des outils de
recherches de chaines de caractéres de Linux (‘grep’, ‘awk’, ‘tr’) les données de la partie
Time.Estimated.

Mon script utilise ces données pour incrémenter des variables qui seront finalement additionnées pour
obtenir le temps maximal estimé (exemple de sortie ci-dessous) :

Le temps maximal total de calcul est de
année (s) jour (s) heure (s) minute (s) seconde (s)

Il est important de noter que les temps indiqués par Hashcat sont les temps maximaux. Cela signifie
que le cassage peut prendre moins de temps.

Méme avec des optimisations de recherches, 1’attaque par force brute prend du temps. J’ai continué
mes travaux sur le cassage de mots de passe en m’intéressant aux tables arc-en-ciel.

L’avantage de ces tables est qu’elles permettent de trouver trés rapidement un mot de passe, et elles
restent un des moyens les plus rapides et efficaces pour casser un mot de passe. Cependant elles
nécessitent un grand espace de stockage, et la taille des mots hachés a 1’intérieur est limitée car la
génération de ces tables prendrait trop de temps.
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4.2 Analyse de radio fréquences

Pour cette seconde mission, la cellule C3D m’a confié un boitier SDR, Software-Defined Radio, qui
est un récepteur et émetteur utilisant principalement des logiciels et limite un maximum | utilisation

matériel.

C’est un outil tres pratique car il permet de faire a peu prés ce qu’on veut avec et est contr6lable par

commandes.

Figure 1 - Un HackRF One

Pour gagner du temps sur une analyse de signal, il est conseillé de se renseigner sur I’objet qu’on étudie,
notamment sur sa fréquence d’émission. Pour mes premiers essais, j’ai utilisé un boitier de commande
de portail FAAC. Apreés de courtes recherches, j’ai trouvé sa fréquence d’utilisation qui est autour de

868.35 Mhz (Annexe c - Boitier de commande FAAC).

Pour I'utiliser, il est nécessaire d’installer les paquets hackrf et libhackrf-dewv, le brancher a
un ordinateur avec un cable USB — Micro USB et taper sudo hackrf info dans une invite de

commande pour veérifier le matériel (Figure 2).

hackrf info version: unknown

libhackrf version: unknown (0.5)

Found HackRF

Index: O

Serial number: 0000000000000000453c64c82287258f
Board ID Number: 2 (HackRF One)

Firmware Version: 2015.07.2 (API:1.00)

Part ID Number: 0xa000cb3c 0x008a4769

Figure 2 - Résultat de la commande hackrf_info
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4.2.1 Detection avec GQrx

Garx est un logiciel de visualisation et d’écoute de fréquences. Il est capable de renvoyer sous forme
sonore les signaux recus (oui, on peut écouter la radio avec, j’ai testé).

La premiére fenétre qui apparait est la sélection du SDR (Figure 3).

I/Q input

Device | HackRF HackRF One 87:

Device string
Input rate

Decimation
Sample rate

Bandwidth

LNE LO

hackrf=87258f
000000

Mone
8.000 Msps
0,000000 MHz

0,000000 MHz

Audio output

Device | Default -
Sample rate 48 kHz -
| oK | J Cancel

Figure 3 - Sélection du récepteur-émetteur, ici le HackRF

Apreés avoir choisi mon appareil de réception, le HackRF, j’ai réglé quelques parametres (Figure 4).
Dans la rubrique Input Controls, j’ai coché la case DC Remove pour enlever le pic central. Ce pic est
dd au convertisseur et n’est pas important, il peut étre génant si la fréquence de 1’appareil émetteur est
vraiment proche.

J’ai ensuite réglé la frequence (Receiver Options > Frequency) sur 868.35 Mhz (la fréquence trouvée),
et le mode sur Demod Off (car on ne connait pas encore la modulation utilisée).
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File Tools View Help
misE N &L
Receiver Options @

868.350.000 o

Hardware freq: 868.350000 MHz

Frequency 868350,000 |3 | kHz
Filter width | User (93 k) v
Filter shape | Normal

Mode | Demod Off

Al <[]«

AGC | Medium
Squelch | -150,0dB |+ A R

Noise blanker NB1 NB2

Input controls Receiver Options FFT Settings

Audio B

-20

-40

Click, drag or scroll on spectrum to tune. Drag and scroll X and Y axes for pan and zoom. Drag filter edges to adjust filter.

Figure 4 - Paramétrage du logiciel

Si on veut étre vraiment précis, il faut régler la fréquence sur une valeur supérieure ou inférieure a la
fréquence que 1’on veut analyser car il y aura tout de méme des pics di au CAN - convertisseur
analogique-numeérique - au centre (donc sur la fréquence réglée) du spectre.

La valeur de Filter width a été choisie automatiquement par le logiciel en fonction des parametres du
SDR sélectionné.

Il faut savoir qu’on travaille seulement avec un signal numérique. Un ordinateur n’est pas en mesure
de traiter une infinité de points (signal analogique). Gqrx échantillonne le signal regu, ¢’est-a-dire qu’il
sélectionne des points du signal a des intervalles de temps réguliers.

Dans FFT Settings, il faut sélectionner une grande valeur pour I’option FFT Size. FFT signifie Fast
Fourier Transform ou transformation de Fourier rapide. C’est un algorithme de calcul de la transformée
de Fourier discrete massivement utilisé en téléecommunication. Une transformee de Fourier est une
représentation en fréquence d’un signal. La transformée de Fourier discréte est la représentation
spectrale (en fréquences) d’un signal discret (échantillonné).

Cela va augmenter le nombre de points sélectionnés pendant 1’échantillonnage, donc permettre de se
rapprocher du signal de base, et donc d’avoir des valeurs plus précises/correctes. Plus la valeur est
grande, plus le CPU aura besoin de ressources.

Sur la figure ci-dessus, la partie supérieure est la transformée de Fourier discréte du signal captée par
I’antenne du HackRF. La partie inférieure est appelée « cascade ». Elle représente 1’évolution de la
puissance des frequences (en couleurs, les plus foncées représentant souvent du bruit, puissance faible)
en fonction du temps (de haut en bas).
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Lorsque j’ai appuyé sur le boitier, j’ai observé ’apparition d’un pic légérement en dessous de la
fréquence de référence (Figure 5).

File Tools View Help
miELE VN E R =
Receiver Options @®

868.350.000 e —

Hardware freq: 868.350000 MHz

Frequency 868350,000 |5 | kHz
Filter width | User (93 k) >
Filter shape | Normal

Mode | Demod Off

ol <[]«

AGC | Medium
Squelch | -150,0 dB | A R

Noise blanker NB1 NB2

Input controls = Receiver Options | FFT Settings

Audio B®

-20

-40

‘J""[‘:;',“"‘/"J;\"‘.A"‘-r gy

Click, drag or scroll on spectrum to tune. Drag and scroll X and Y axes for pan and zoom. Drag filter edges to adjust filter.

Figure 5 - Réception du signal du boitier

Sur la capture, dans 1’affichage en cascade, on peut voir distinctement qu’un signal a été regu. Il y a
plusieurs impulsions visibles car j’ai appuy¢ plusieurs fois sur le boitier pour des essais. Aprés avoir
prélevé la fréquence du boitier, je suis passé sur URH.

4.2.2 Analyse avec Universal Radio Hacker (URH)
URH est un logiciel trés complet qui permet d’effectuer de la rétro-ingénierie sur des signaux.

J’ai  téléchargé les  fichiers  d’installation  proposés par D’auteur sur  Github
(https://github.com/jopohl/urh). 1l faut installer un grand nombre de paquets python pour pouvoir
installer URH. La commande ci-aprés, a taper dans un terminal, permet d’installer tout ce qu’il nous
faut d’un coup.

sudo apt install python3-numpy python3-psutil python3-zmg python3-
pygtb g++ libpython3-dev python3-pip cython3

Pour installer URH, il faut se placer dans le dossier contenant les fichiers d’installation, et le fichier
‘setup.py’, ’installeur, et taper la commande sudo python3 setup.py install.
Le logiciel doit étre lancé avec les droits administrateur (sudo).

Pour effectuer les analyses, il est nécessaire d’avoir un fichier contenant des données d’un signal. 1l est
possible d’ouvrir directement un fichier, ou d’enregistrer directement un signal avec le logiciel et le
récepteur.
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On arrive sur une fenétre dans laquelle il faut choisir 1’appareil de capture et ajuster la fréquence dans
la rubrique Frequency (Hz). J’ai indiqué qu’on utilise le HackRF, puis j’ai rentré la fréquence trouvée
avec Ggrx (868.287 Mhz). Il faut aussi cocher la case DC correction pour éviter le pic central (vu plus

haut avec Gqrx).
On lance I’enregistrement (Start) puis on active notre émetteur. Ici j’ai appuyé 3 fois sur mon boitier,

et j’ai obtenu le signal Figure 6.

v Device settings Y-Scale

Device: HackRF

Device Identifier: -
Frequency (Hz): 868,287M

Sample rate (Sps): 2,000M

Bandwidth (Hz): 2,000M

Gain: 0

IF Gain: — 16

30

Baseband gain:

DC correction: v Apply DC correction
®©@ ® |14 €
Start Save... || Clear

Samples captured:

9,3M
Receive buffer full:
0%
Signal size (in MiB):
71,00
Time (in seconds):
4,65

HackRF-SETUP: Success

HackRF-SET_FREQUENCY to 868287000.0: Success
HackRF-SET_SAMPLE_RATE to 2000000.0: Success
HackRF-SET_BANDWIDTH to 2000000.0: Success
HackRF-SET_RF_GAIN to 0: Success

HackRF-SET_IF_GAIN to 16: Success

HackRF-SET_BB_GAIN to 30: Success

HackRF-Start RX MODE: Success

HackRF: successfully started rx mode -

Figure 6 - Capture du signal de 3 appuis du boitier

J’ai enregistré mon signal, puis je suis retourné sur I’écran initial d’URH. Pour lancer les analyses, il
faut ouvrir le fichier qu’on vient d’enregistrer. Il est possible (et obligatoire pour effectuer les analyses)
de zoomer sur le signal pour une vision plus clair.

Dans mon exemple, 1’analyse se fera sur la deuxiéme partie du signal (le dernier gros ‘paquet’ de
sinusoides) car c’est 1a que les variations sont le plus présentes et traduisent la présence d’informations.
J’ai di effectuer le traitement en 2 étapes :

« déterminer la modulation utilisée

» trouver combien d’échantillons (sample en anglais) composent un bit (1I’option Bit Length, Figure 7).
Ces informations permettront ensuite d’arranger de maniére cohérente les données recues, de fagon a
ce qu’elles correspondent aux variations du signal.

DUT R&T - Stage 2019 - COL - EDF DIPDE 14



File Edit Help

Interpretation | Analysis | Generator = Simulator

1: Complex Signal ® e 0 Y-Scale
3_appuis_fé

Noise: 0,0204

Center: 0,1237

Bit Length: 100

Error Tolerance: |9

e (O] [ar] [r] [

Modulation: ASK -

Y

4

Autodetect parameters

4 »
& 520 selected | 260,00 ps | -6,06 dBm 7 Filter (moving average) [

111111111111111111111111111111111111111111111111111111111111111111117111111111111111111111711111111111111111111111 =
11111111111111111111111111111111111111111111111111117111111111111111171111711111111111111117111111117111111171111111
1111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111
111111111111111111111111111111111111111111111111111111111111111111113111111111111111111111711111111111111111111000
00 [Pause: 50056 samples]

1111100 11111 00011111 11111 11111606000011111 11111 1111100000011111111111111111111110
0000 [Pause: 1785 samples]
Signal View: Analog ~/111111111111000000111110000000000001111111111100 11111 11111 11111 011111
0000001111100060060000011111111111000060011111111111006000011111000000000001111111111100000011111600000000000111111
v/ Show Signal as | Bits ~ | 00000000000fHEEEI000000000000111110000000000F011111111111060000111110000000000AA111111111110000001111111111160000 ~

‘Warning: You are running URH in non project mode. All your settings will be lost after closing the program. If you want to keep your settings create a project via File -> New Project. Don't show this hint

Figure 7 - Zoom et sélection sur la 2iéme partie du signal

Sur la capture ci-dessus j’ai conclu que la modulation était une modulation d’amplitude (Amplitude
Shift Keying, le « ASK » de I’option Modulation a gauche), c¢’est-a-dire que 1’amplitude du signal va
varier en fonction des bits a transmettre (cf. Annexe d - Exemple de modulation d'amplitude)

On remarque tres facilement sur la Figure 7 que les bits ‘1’ sont représentés par une amplitude non
nulle, et inversement pour les bits ‘0’. J’ai donc sélectionné le plus court symbole possible dans mon
signal, qui est la représentation d’un bit, et j’ai reporté le nombre d’échantillons indiqués (520 selected)
dans Bit Length.
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File Edit Help

Interpretation | Analysis =~ Generator = Simulator

1: Complex Signal IQ\ \E\ |§| Y-Scale
\37appui5j6 | 7
Noise: 10,0204 g
Center: 10,1237 g
Bit Length: /520 B
Error Tolerance: \:@
Modulation: ASK -|[&
| Autodetect parameters E|
El me-
\E\ 2216 selected | 1,11 ms | -8,80 dBm |7 Filter (moving average) E|

1111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111 |~
1111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111
1111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111110 [Pause: 50056
samples]
101010101016101011110000110100116fF[F061001001001101101001101001001001601101601101101001101001101101101101001101
0010010011011010011011011011010011010011010010010010016611611611010611010011010011011011010011011011611611110060
1101001101001001001001001101101061161061001001001101001101101001101001101101161101001101001001001101101001101101
1011010011010011010010010010010011611011010011010011010011011011010011611011011611110000110100110100100100100100
1101101001101001001001001101601161161061101001101101101101001101001001601101161601101161161101001101001101001001
0010010011011011016011010011010011011011010011011011011611110600110100110100100100100100110110100110100100100160
11010011011610011010011011011611616611610010010011011010011011011011016011016061101001001001001001101101101001101
) . | 0011010011011011010011011011011011116060110100110100100100100100110110100110100100100100110100110110100110100110
ElanEle |Analog  -| 1191191101001101001001601101101001161101101101091101001101001601001081001101101181091101001161001101101101081101
v Show Signal as \B|t57v| 10110110 [Pause: 1115481 samples]

1A [Mamca. 74102 coamnlacl 74

‘Warning: You are running URH in non project mode. All your settings will be lost after closing the program. If you want to keep your settings create a project via File -> New Project. Don't show this hint

Figure 8 - Vérification des valeurs

Pour Vérifier que la valeur soit correcte, j’ai sélectionné une suite de bits sur la trame sous le signal, et
on peut voir sur la Figure 8 qu’ils correspondent a la forme du signal : la sélection commence par un
bit ‘1°, et I’amplitude du signal est non nulle. Ce bit est suivi par 2 bits ‘0’, traduits par une amplitude
nulle sur le signal. Le dernier bit de la sélection est ‘1’, et on retrouve le symbole correspondant.

Je suis ensuite retourné dans la partie Analysis. Les transmissions radio a courtes distances utilisent le
plus souvent le codage Manchester mais dans notre cas le boitier de commande utilise un codage
propriétaire SLH LR (brevet FAAC). C’est un code qui varie a chaque utilisation (Self Learning
Hopping code, code tournant) et qui est reconnu seulement si le signal des émetteurs a été codé par le
récepteur.
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File Edit Help

Interpretation Analysis | Generator =~ Simulator

Protocols | Participants Enter pat

~ v/ E5 New group 1(2|3|4|5
V| 3_appuis_fé 18
2|8
3|5
4| fF f b 6 0
58
6 8
View data as:
(7|4
Hex ~
- n 8 4
Configure Decoding:
Manchester II - 9, f f b 6 0
; Decoding errors for message: 10 8
No message selected Bl =
12| 5
Mark diffs in protecol
13| f f b 6 0
Show only diffs in protocol
Show only labels in protocol
Analyze ™ Bit: 0010
Message types

Name Edit Name Color

V| Default

== Add new message type

@b search v @ - /-5

6 7 8 9 10 11 12

Hex: 2

Display format  Order [Bit/Byte]

13 14

Value

-20,65 dBm

15 16 17 18 19 20 21

Decimal: 2

Labels for message #8

22

Timestamp: 594,00 ms (56,51 ms) H| =

2526 27 |28 29 30 31 32 33 34 35 3

L]

7 6 1 b b 7

1 d 8 6 e d

Warning: You are running URH in non project mode. All your settings will be lost after closing the program. If you want to keep your settings create a project via File -> New Project. Don't show this hint

Figure 9 - Trame peu lisible

d 8 e 6 1

f 8 3 b ¢

f b 0 1 ¢

1 column(s) selected

La Figure 9 permet d’observer que les données ne sont pas claires, n’ont pas de formes particuliéres.
Je suis retourné dans Interpretation et j’ai remarqué que la derniére partie de chaques signaux pouvait
étre sectionnée en 6 sous-parties (Figure 10).

4
Figure 10 - 2e partie du signal

Mais le logiciel ne sélectionne pas les données ‘a I’ceil’, il le fait en fonction du nombre de bit ‘0’ a la
suite. Cette option est réglable en cliquant sur la clé a molette a co6té de 1’option de modulation, puis
en modifiant la valeur de Pause Threshold. J’ai mis la valeur 2 car elle divise les données (la suite de
bits) en 6 parties et correspond a mon observation précédente.
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En retournant dans la partie Analysis, j’ai sélectionné le codage Manchester II pour voir la forme des
données. On remarque Figure 11 qu’elles sont beaucoup plus ‘lisibles’, mais inexploitable de maniére
correcte car le code réel utiliseé est le codage SLH LR de FAAC.

File Edit Help

Interpretation Analysis Generator | Simulator

Protocols | Participants Enter pattern here @ Search |v| @ -/ - |5
~ v 5 New group 1(2[3][4][5][6]7 9 10 11 12
V| 3_appuis_f6 18
2 | 8
3 4
4 4
5 f f &8
6 d 8 3 b 0 d d b e c 7 3
view data as: 7 d 8 3 b 0 d d b e c 7 3
Hex ~fis8|d 8 3 b 0 d d b e c 7 3
Configure Decoding: 9 d 8 3 b 0 d d b e c 7 3
Manchester Il -
0d 8 3 b 0 d d b e c 7 3
Decoding errors for message:
No message selected ns
12 8
13 4
Mark diffs in protocol 14/ 4
Show only diffs in protocol 5 f f
Show only labels in protocol 6 d 8 3 b 0 d d b e ¢ 7 7
Analyze ™ Bit: 0010 Hex: 2
Message types
Name Edit | Name Color Display format | Order [Bit/Byte]

V| Default v

< Add new message type

-20,65 dBm Timestamp: 594,00 ms (+56,51 ms) H S

13 14|15 16 17 18 19|20 21 =

w oW ow ow ow
o o o T o
@ ® @ ® ®
[
~ o~~~ N
na a a a

d b 0o 7 b 6 f 7 ¢

Decimal: 2 1 column(s) selected

Labels for message #8

Value

Warning: You are running URH in non project mode. All your settings will be lost after closing the program. If you want to keep your settings create a project via File -> New Project. Don't show this hint

Figure 11 - Données structurées

Afin de continuer mes tests, j’ai changé de boitier de commande pour un modéle plus ancien. Le T224-
1 de FAAC (oui, encore eux), fonctionnant sur une fréquence de 224.7 Mhz.

La technique de codage de ce boitier est le dip-switch (mini-interrupteur). Ce codage est réglé

manuellement par 1’utilisateur en changeant 1’état de mini-interrupteurs présents dans le boitier. La

séquence doit étre la méme que le récepteur. Dans le boitier T224-1, le systéeme possede 8 mini-

interrupteurs a 3 états (1,0,-1).

Contrairement au boftier précédent, le signal de celui-ci est beaucoup plus lisible et on remarque a I’ ceil

Figure 12, la présence d’un motif qui se répete.
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File Edit Help

Interpretation | Analysis =~ Generator = Simulator

1: Complex Signal H ® 60 Y-Scale
FAAC-t224-1

Noise: 0,0208 :

Center: 0,0437 :

Bit Length: 2900 -

Error Tolerance: 0

Modulation: ASK - ||

Autodetect parameters |

#& 0 selected 0,00 ns | - dBm 7 Filter (moving average)

11111111111111111111111111111111111111111111111111 [Pause: 173557 samples]

Signal View: Analog -

v Show Signal as  Bits -

Warning: You are running URH in non project mode. All your settings will be lost after closing the program. If you want to keep your settings create a project via File -> New Project. Don't show this hint

Figure 12 - Signal regu, 1 appui

Cependant la trame en bit est composée seulement de ‘1°. Cela est dii au seuil minimal d’amplitude
défini automatiquement par le logiciel lors de la démodulation. Pour régler ca je suis allé dans la vue

démodulée du signal (Signal View : Demodulated) puis j’ai ajusté manuellement le niveau de la partie

‘0’ (Figure 13, en rose). Par la méme occasion j’ai sélectionné le nombre d’échantillons d’un bit (méme
fonctionnement que pour le boitier précédent), qui est de 3020. Ici I’option pause threshold (seuil qui

permet de sectionner les messages) a été correctement auto paramétrée.

File Edit Help

Interpretation Analysis Generator Simulator

1: Complex Signal |H||® & © Y-Scale
FAAC-t224-1
Noise: 0,0208 s
Center: 0,0707 -
Bit Length: 2900 :
Error Tolerance: |0 .
Modulation: ASK v |4
Autodetect parameters ™| R a =
K] »
& 0 selected | 0,00 ns - dBm 1 Filter (moving average) v

1100010001000100010111601100110011601116111601168
01100000011000100[10001000101110011001160110111011160110011000 [Pause: 173557 samples]

Signal View: Demodulated ~

v/ Show Signal as |Bits v

Warning: You are running URH in non project mode. All your settings will be lost after clesing the program. If you want to keep your settings create a project via File -> New Project. Don't show this hint

Figure 13 - Vue du signal démodulé

La seéquence des mini-interrupteurs du boitier est [1111-1000. Pour comprendre comment le code

fonctionne, j’ai changé la séquence précédente pour comparer ensuite les données.
Nouvelle séquence : [11111111].
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File Edit Help
Interpretation | Analysis =~ Generator = Simulator

1: Complex Signal H® 6 e Y-Scale
FAAC-t224-1-(11111111) )
Noise: 0,0190
Center: -0,3242
Bit Length: 100

Error Tolerance: 2

Modulation: PSK

Autodetect parameters "]

0 »
& 0 selected 0,00 ns | -e= dBm 1 Filter (moving average) [~
1111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111131111111111111111111 *
111111111111111111111111111111111111111111111111111111111111111111111131111111111111111111171111111111111111111111
111111111111111111111111111111111111111111111111111111111111111111111131111111111111111111171111111111111111111111
111111111111111111111111111111111111111111111111111111111111111111111131111111111111111111171111111111111111111111
111111111111111111111111111111111111111111111111111111111111111111111131111111111111111111171111111111111111111111
1111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111
1111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111

Signal View: Analog ~1111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111

- 1111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111
¥ Show Signal as | Bits T/11111111111111111111111111111111111111111111111113111111111111111111111111111111131111111111111111111111111111111 ~

Warning: You are running URH in non project mode. All your settings will be lost after closing the program. If you want to keep your settings create a project via File -> New Project. Don't show this hint

Figure 14 - Signal recu pour la séquence '11111111*

Encore une fois, un motif se répéte. Le fonctionnement du code commence a étre clair : la premiére
impulsion est un préambule qui annonce le début du code, s’ensuit le code des mini-interrupteurs. J’ai
clairement pu observer les 8 impulsions fines représentant les 8 ‘1’ (Figure 14) que j’ai réglé. La fin
d’émission est annoncée par 2 impulsions plus longues, suivies de 2 impulsions moyennes.

J’ai une fois de plus changé de séquence :. On peut voir Figure 15 que le signal posséde
toujours les mémes caractéristiques : impulsion d’amorce, 8 impulsions correspondant aux mini-
interrupteurs, 4 impulsions de fin de signal. Pour I’envoie de la séquence des interrupteurs, les

impulsions longues traduisent la valeur -1, les impulsions moyennes la valeur 0, et les impulsions
courtes la valeur 1.

File Edit Help
Interpretation | Analysis = Generator | Simulator

1: Complex Signal |H ® @ © Y-Scale
FAAC-t224-1(-1-1-100111) )
Noise: 0,0199
Center: 0,0915
Bit Length: 3020

V] [ [

Error Tolerance: |0
Modulation: ASK - ||*

Autodetect parameters "l

&/ 0 selected | 0,00 ns | - dBm T Filter (moving average) |

110111011101116011001100010600100010111611100116011 [Pause: 0 samples]

Signal View: Analeg -

¥ Show Signal as | Bits M

Warning: You are running URH in non project mode. All your settings will be lost after closing the program. If you want to keep your settings create a project via File -> New Project. Don't show this hint

Figure 15 — Signal recu pour la séquence ¢-1-1-100111°

Dans la figure suivante, j’ai labellisé (surligné les différentes parties) et rassemblé les 3 signaux pour
les comparer. De haut en bas, le signal avec le code initial ‘1111-1000’, le code ‘11111111°, et le code
-1-1-100111".
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File Edit Help

Interpretation | Analysis | Generator = Simulator

Protocols | Participants Enter pattern her

~ v E5 New Group LainZnindaintsinisint
V| FAAC-t224-1 111 0@ 0 1

V| FAACt224-1-(11111111)
V| FAAC-t224-1(-1-1-100111) 2

11 08 0 1 0
View data as: tror1ae
Bits ~
Configure Decoding:
Non Return To Zero (NRZ) -
Decoding errors for message:
No message selected
Mark diffs in protocol
Show only diffs in protocol
Show only labels in protocol
Analyze " Bit:
Message types
Name Edit | Name Colo:
v Default #" ||V preamble D
V| code [}
v| end/close ]

< Add new message type

B

o

o

# Search [v @ -/ - |5 0,55 dBm Timestamp: 0,00 ns (+0,00 ns) H| [

9 10 1112[13 14 15[16[17 18 10|20 21 22|23 |24 2526 2728|2030 313233 34[35 36 37 38|30 40 41[42 43 44[45 46 47 48)40 50

© 1 00 0 1 090 010 1 1109001109001 10601 1 6 1116111601100 1 1

o 1 090 0 1 0 90 0190 0010001 ¢0 41 ¢ 00 1 6 1118111601100 1 1

110111900 1190110001000 1 0600 1 0 1 1 1 011106011 00 11

Display format
Bit

Bit

Bit

Decimal: 0 column(s) selected

Labels of Default
Order [BityByte]  Value
MSB/BE

MSB/BE

MSB/BE

Warning: You are running URH in non project mode. Al your settings will be lost after closing the program. If you want to keep your settings create a project via File -> New Project. Don't show this hint

Figure 16 - Comparaison et labellisation des 3 signaux

4.2.2.1 Mise en patique

Sachant que le codage est simple, sans roulement, j’ai essayé d’effectuer un rejeu sur le portail
correspondant a mon boitier. Le principe du rejeu est de capter le signal d’ouverture, et de le rejouer

tel quel, sans modification.

Ce portail est chez moi, tout est Iégal. Pour le rejeu j’ai utilisé le HackRf One.

sudo hackrf transfer -r 224.7Mhz-10M.complexl6es -f 224700000
call hackrf set sample rate (10000000 Hz/10.000 MHz)
call hackrf set freq(224700000 Hz/224.700 MHz)

Stop with Ctrl-C

19.9 MiB / 1.000 sec
19.9 MiB / 1.000 sec
19.9 MiB / 1.000 sec
20.2 MiB / 1.000 sec
19.9 MiB / 1.000 sec

~*CCaught signal 2
19.9 MiB / 0.994 sec

Exiting...

Total time: 5.99456 s
hackrf stop rx() done
hackrf close () done
hackrf exit () done
fclose (fd) done

exit

19.
19.
19.
20.
19.

O N O WO

20.

[EY

MiB/second
MiB/second
MiB/second
MiB/second
MiB/second

MiB/second

Figure 17 - Commande d'écoute et son résultat

J’ai indiqué a mon SDR qu’il doit enregistrer le signal dans un fichier avec 1’option —r (record in
english), sur la fréquence de mon boitier (244.7Mhz) avec I’option —f.
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Je me suis placé a proximité du récepteur de mon portail puis j’ai lancé la commande
hackrf transfer. Cette fois c’est —t, pour transfer, qui indique quel fichier doit étre utilisé. Pour
le rejeu, j’ai tout simplement utilisé le fichier que j’ai créé avec la commande d’enregistrement. On
retrouve 1’option —f pour la fréquence d’émission, et une nouvelle option, -x, qui indique le gain de la
puissance d’émission du hackRf en décibel. Cette option est indispensable car méme a c6té d’un
récepteur, sans cette option, le signal émis peut ne pas étre regu.

sudo hackrf transfer -t 224.7Mhz-10M.complexl6s -f 224700000 -x 40
call hackrf set sample rate (10000000 Hz/10.000 MHz)

call hackrf set freq(224700000 Hz/224.700 MHz)

Stop with Ctrl-C

19.9 MiB / 1.000 sec = 19.9 MiB/second

19.9 MiB / 1.000 sec = 19.9 MiB/second

19.9 MiB / 1.000 sec = 19.9 MiB/second

20.2 MiB / 1.000 sec = 20.2 MiB/second

11.0 MiB / 1.000 sec = 11.0 MiB/second

Exiting... hackrf is streaming() result: streaming terminated (-
1004)

Total time: 5.00103 s
hackrf stop tx() done
hackrf close() done
hackrf exit() done
fclose (fd) done

exit

Figure 18 - Commande d'émission et son résultat

Sur la Figure 18 on peut voir que le HackRF est en émission : ‘hackrf is streaming( )’. En me plagant
a coté du portail (Annexe f), j’ai réussi a I’ouvrir avec cette commande, donc du rejeu. Le HackRF
N’est pas un matériel trés précis, I’antenne est universelle, il y a beaucoup de pertes, c’est pour ¢a qu’il
faut se placer a proximité de notre objectif, ou alors utiliser des amplificateurs (autres que 1’option —X,
de vrai amplificateurs) et autres techniques.

Les travaux que j’ai effectues et détaillés au cours de cette partie vont aider la cellule C3D dans laquelle
j’ai travaillé a réaliser des audits dans le domaine industriel.
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5 Conclusion

Au cours de mon stage au sein de la cellule C3D, malgré un environnement trés confidentiel, j’ai pu
apporter mon soutien dans la réalisation et la mise en place de systemes qui permettront a la cellule
d’auditer des projets de la DIDPE et de la DPNT de maniére plus générale.

Ce stage d’immersion en entreprise m’a permis de découvrir le milicu de la cyber-sécurité, qui est tres
demandeur aujourd’hui, et qui devient indispensable avec la numérisation des données.

Ce domaine necessite une grande rigueur, et des connaissances rédactionnelles avec de la
communication adaptée pour pouvoir énoncer clairement les besoins en termes de sécurité.
Contrairement aux idées recgues, «les ingénieurs en cyber-sécurité ne font pas que de la
programmation », mais sont sollicités en grande partie pour la rédaction de rapports et des propositions
de solutions de sécurités.

J’ai pu observer des systémes réseaux et du matériel opérationnel, comme les salles de controle
commande, des salles serveurs et beaucoup d’équipements liés a la cyber-surveillance.

Travailler dans ce milieu m’a éclairci dans mes choix de carriéres. La sécurité informatique est un
domaine qui m’intéresse, autant que la programmation, deux domaines dans lesquels j’aimerais
travailler.
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Glossaire

API : Application Programming Interface. C’est une fagade par laquelle un logiciel offre des
services a d’autres logiciels.

Bash : Abréviation de « Bourne-Again shell ». C’est un interpréteur en ligne de commande présent
sur de nombreuses distributions Linux.

C3D : Centre de Compétences en Cyber-Sécurité de la DPNT.

Charset : Fusion des mots « character » et « set », traduisible directement par « un ensemble de
caracteres ».

Cluster : Un cluster ou grappe de serveurs et permet de rassembler les performances de plusieurs
machines, de fusionner leurs ressources, a travers un réseau.

DIPDE : Division de I’'Ingénierie du Parc, de la Déconstruction et de I’Environnement.
DIPNN : Division de I’Ingénierie du Parc, Nouveau Nucléaire.

DPNT : Direction du Parc Nucléaire et Thermique

EDF : Electricite de France.

ENEDIS : Gestionnaire du réseau de distribution d’¢lectricité, anciennement ERDF (pour
Electricité Réseau Distribution France) (haute tension A (ex. moyenne) et basse tension — 20 kV a
230-220 V).

GPU : Graphics Processing Unit. C’est un circuit intégré présent sur la plupart des cartes
graphiques qui effectue les fonctions de calcul et d’affichage.

Keyspace : Désigne I’ensemble des possibilités ou combinaisons pour un mot d’une certaine taille,
composé de certains caractéres. Le nombre de possibilité pour un mot = (nombre de valeurs pour 1
caractere)(nombre de caracteres).

Machine virtuelle : Simulation d’un appareil informatique, sur un ordinateur physique a 1’aide
d’un logiciel. Abrégeé en ‘VM’ (Virtual Machine).

OpenCL : « Open Computing Language est une API permettant de tirer parti de la puissance des
GPU, en d'autres termes, OpenCL permet au programme d'utiliser la carte graphique pour faire
des calculs, paralléelement ou séparément des calculs faits par le processeur » (reneca, 2 Ao(t,
2014, Wiki ubuntu-fr). Cette API est désormais présente dans presque tous les GPU et processeurs.

Rétro-ingénierie : La rétro-ingénierie est le principe d’observer le fonctionnement interne d’un
systeme.

RTE : Gestionnaire du Réseau Transport d’Electricité (haute tension B de 400kV a 63kV).

Script : Programme simple et court permettant d’automatiser 1’exécution des taches simples et
répétitives, comme des suites de commandes, des modifications de fichiers etc...
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Systeme 868 MHz SLH LR

Mombre de canaux Fréeguence d'utilisation

2-4 868,35 MHz

Annexe ¢ - Boitier de commande FAAC

1v

Ov

Input binary sequence

1v

Ov
-1v
ASK Modulated output wave

Annexe d - Exemple de modulation d‘amplitude
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Annexe e — Un ‘dip-switch’ de 8 interrupteurs

Annexe f — Mon installation d’essai de rejeu
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Documentation Hashcat

OPTIONS

-a (--attack-mode)  : type d’attaque (3 pour le brute-force)

-m (--hash-type) : type de hash.

-0 (--output-file) : fichier qui contiendra les mdp crackés.

-O (--optimized-kernel-enabled) : Utilisation de noyaux hashcat plus performants, mais limitation de
la taille des mots de passe (en fonction de I’algo. de hash). Cependant la vitesse de calcul est
multipliée par 2.

-w (--workload-profile) : défini le mode de consommation d’énergie et donc la puissance.

-1 (--custom-charstet1) : défini un charset applicable & un masque.

Max 4 charset (-1 -2 -3 -4).

--increment --increment-min=/ --increment-max= : permet de délimiter I’espace de recherche.
fichier_de_hash : fichier contenant les hash de mot de passe.

Masque : la forme du mot de passe

Forme typique :
hashcat -a [#] -m [#] -o [nom_fichier] -O -w [#] -1 [?x...] --increment --increment-min=[#] [fichier_de_hash] [masque]

EXPLICATIONS

Fichier de hash
Si le fichier contient des hash de différents type, hashcat va ignorer ceux qui ne correspondent pas a la
méthode annoncée avec 1’option -m.

Le masque

Derniére option d’une commande hashcat, le masque sculpte le mot de passe. Il permet d’affecter a
chaque caractére une plage de valeurs (par valeurs il est entendu minuscules, majuscules, chiffres,
caracteres spéciaux...).

Par exemple, pour définir que le/les mots de passe recherchés commencent par une majuscule
seulement, puis sont composeés de 3 minuscules et terminés par un chiffre, il faut

écrire 2u?1?1?1?2d (cf « Valeurs »). Il ne faut pas oublier le « ? ».

Si un charset a été défini, il est utilisable comme ceci : 21?121 ... (1 correspond au numéro du charset).
Dans le masque, un charset peut étre combiné avec une plage de valeurs: ?1?u?1?d
Il faut spécifier un masque personnalisé (voir paragraphe rouge ci-dessous).

Définition d’un charset

Un charset permet de combiner plusieurs plages de valeurs, sous une seule donnée. L’utilisation des
charset se fait lorsque des caracteres peuvent valoir différentes plages de valeurs (minuscules et
chiffres...).

L’option -1 (ou -2 etc...) doit étre suivie des valeurs que pourront prendre les caractéres affectes a ce
charset.

Par exemple, il est possible de dire que le charset 1 est composé de majuscules ou de minuscules en
écrivant -1 ?1?u (I’ordre de placement de ?l et ?u [exemple] n’as pas d’importance, ce n’est pas un
masque, mais un regroupement de plages de valeurs).

En écrivant ?1?1?1 comme masque par exemple, on dit que le/les mots de passe sont composes de 3
caractéres pouvant étre soit des minuscules (?1) soit des majuscules (?u).
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Si aucun charset n’est défini, hashcat prendra ceux définis par défaut et les appliquera a un
masque lui aussi par défaut (majuscule seulement au premier caractéere, caractéres spéciaux
préesent a partir du 7¢ caractere). Il faut donc spécifier un charset et un masque que vous pensez
en adéquation avec la forme de votre mot de passe/qui pourraient correspondre a n’importe quel
mot de passe.

Increment

Lors de [’utilisation des options d’incrémentations, il faut toujours ajouter --increment.
Increment-min définit la longueur (nombre de caracteres) minimale du mot de passe, increment-max
la longueur maximale.

Par exemple, si on sait qu’un mot de passe a une longueur supérieure ou égale a 5, il faudra écrire --
increment --increment-min=5. Increment-max est disponible, mais n’est pas utile dans notre cas
(longueur max = masque). Si on connait la taille du mot de passe, pas besoin de 1’option increment (cf
Masque & increment).

Masque & increment

*Si pas d’option d’incrémentation, hashcat ne recherchera que des mots de passe de la taille du
masque (avec les charset/formes de caracteres donnés) !

*Si la valeur de increment-min > longueur du masque, ¢a ne marche pas (‘Invalid Mask”).

+Si la valeur de increment-min < longueur du masque, la recherche commencera par les x premiers
caractéres du masque, x étant la valeur de increment-min.

+Si la valeur de increment-max < longueur du masque, la recherche s’arrétera a y caractéres du
masque, y étant la valeur de increment-max.

*Si la valeur de increment-max > longueur du masque, la recherche s’arrétera a la longueur maximale
du masque (increment-max n’aura aucune influence).

Exemple :
hashcat -a 3 -m 0 -o found.txt -O -w 4 -1 ?|1?u?d --increment --increment-min=3
password.hash ?1?1?1?1?1?1

-a3 => brute-force

-mO0 => raw MD5

-0 found.txt =>» mdp crackés sont écrits dans found.txt

-O => 1l est vivement conseillé d’utiliser cette option d’optimisation !

-w 4 =>» Consommation maximale, pleine puissance

-1 ?1?u?d =>» Charset 1, ici : soit min. soit maj. soit chiffresde 0 a 9

--increment =>» On avertit qu’on utilise les options d’incrémentation

--increment-min=3  =» Le crack commence directement par des mdp de 3 caracteres

password.hash => fichier contenant le/les hash a cracker

717171717171 =>» Masque de 6 caractéres pouvant prendre les valeurs décrites dans le
charset 1.

Le programme va exécuter une attaque brute-force sur un hash de type raw MD5 (écrit dans
password.hash). Le charset 1 définit la regle suivante : le caractére ne pourra étre que minuscule ou
majuscule ou chiffre. Il est spécifié que la recherche doit commencer a partir des mots de passe de 3
caractéres. Hashcat utilisera donc les 3 premiers caractéres définis dans le masque pour commencer.
Apres avoir essayé toutes les combinaisons pour 3 caractéres, il passe aux mots de passe de 4 caractéres,
et utilise les 4 premiers caractéres du masque, etc... jusqu’a la longueur maximale du masque, c-a-d 6
caracteres.

Cette commande permet de rechercher des mots de passe de 3 & 6 caracteres composés de minuscules,
majuscules, chiffres.
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VALEURS

-m

# Nom
0 MD5

100 SHA-1

1400 SHA-256

1700 SHA-512

500 MD?5 (Unix), Cisco-10S, $1$

7400 SHA-256 (Unix), $5$

1800 SHA-512 (Unix), $6$

POUR LA LISTE COMPLETE = hashcat --help (partie « Hash modes »)

-wW
# | Performance Conso. énergie Effet sur le bureau (affichage)
1 | Faible Faible Minimal
2 | Défaut Eco. Remarquable
3 | Elevée Elevée Ne répond plus (ou presque)
4 | Nightmare Insane Headless

-1 (-2 -3...) / masque

?

Charset

abcdefghijklmnopgrstuvwxyz

|

u ABCDEFGHIJKLMNOPQRSTUVWXYZ
d 0123456789

s “48%& () F+,- 1 <=>?@[\]*_{[}~

a 2172u2d7s
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Script

#!/bin/bash

#Author: Alexandre COL

#19/04/2019

#

#Dernieres modifications: 03/06/2019

#

#Le script se charge de faire tourner une commande hashcat en arriere-plan et
envoie

#des demandes de bypass régulierement (toutes les 30 sec) ce qui va permettre
d'obtenir

#les infos sur le temps de chaque keyspace (si plusieurs).

#I1 calcul ensuite le temps total indiqué par hashcat.

#

#-Le texte d'information utilisateur-
echo -e "\033[4m \033[0m
\

FONCTIONNEMENT

\
\
\ Saisir une commande hashcat.

| Le script se charge de la faire tourner en arriere-plan (screen) et envoie

| des demandes de \033[36mbypass \033[0mtoutes les \033[31m30 secondes\033[0m.

| Cela va permettre de récupérer le temps de calcul annoncé de chaque keyspace
(si plusieurs).

\ Le fichier de log de la cmd screen est \033[31lmtemps total log.txt\033[0m, il
est supprimé et recréé a chaque lancement de ce script.

| Un calcul du temps maximal total en fonction des temps recus est renvoyé.

\

\033[4m]| \033[0m"

#-Saisie par l'utilisateur de la commande hashcat-
read -p "Commande Hashcat :" commande

#-Le test pour le fichier de log de la commande "screen"-
if [ -e temps total log.txt ]; then
rm temps total log.txt
echo -e "\033[33m'temps total log.txt' existe, il a été recréé\033[0Om"
fi
touch temps total log.txt

#-La commande "screen" qui va lancer la commande hashcat parametre en arriere-
plan-

screen -L -Logfile temps total log.txt -d -m -S Hashcat S$commande

sleep 5 #petit délai (en secondes)

#-Tant que la commande hashcat tourne, on envoie des demandes de bypass. Le
screen s'arréte des que hashcat est terminé-

t=0
while screen -list | grep "Hashcat" > /dev/null; do
screen -S Hashcat -p 0 -X stuff "b"
sleep 30
((t+=1))
echo "Bypass: S${t}"
done

sleep 3 #encore un petit delai
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#---Calcul et affichage du temps total---

#Variables qui s'incrémentent et qui permettront le calcul du temps total
sec=0

min=0

hour=0

day=0

year=0

#hashcat donne des temps sous la forme: (XX unité, XX unité). Ici les 2 parties
séparées par la virgule sont traitées.

cat temps total log.txt | grep "Time.Estimated" | awk -F " (" '{print $2}' | tr -d
'S tr -d '")'" | ( while read ligne; do

#La parenthése avant le while permet de rester dans le processus de la boucle
(pour afficher les variables de la boucle aprés le "done")

vall=$ (echo ${ligne} | cut -d " " -f1)
unitel=$(echo ${ligne} | cut -d " " -f£2)
val2=$(echo ${ligne} | cut -d " " -f£3)
unite2=$(echo ${ligne} | cut -d " " -f4)
#lere partie (premiere chaine de type "XX unité") des temps donnés par hashcat
case Sunitel in
*sec¥*)

sec=$ ((sec+vall))
*min*)

min=$ ( (min+vall))
*hour*)

hour=$ ( (hour+vall))
*day*)

day=$ ( (day+vall))
*year*)

year=$ ((year+vall))

esac

#2e partie des temps donnés par hashcat
case Sunite2 in
*sec*)
sec=$ ((sec+vall))
*min*)
min=$ ( (min+val2))
*hour*)
hour=$ ( (hour+val2))
*day*)
day=$ ( (day+val2))
*year*)
year=$ ( (year+val2))

rs

esac
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#Calcul physiquement correcte
par exemple)
sec2=$ ((sec-60))
if (( $sec2 >= 0 )); then
min=$ ( (min+1))
sec=S$sec?
fi

min2=$ ( (min-60))
if (( Smin2 >= 0 )); then
hour=$ ( (hour+1))
min=Smin2
fi

hour2=$ ( (hour-24))
if (( Shour2 >= 0 )); then
day=$ ((day+1))
hour=$hour?2
fi

day2=$ ((day-365))

if (( Sday2 >= 0 )); then
year=$ ((year+1))
day=$day?2

fi

done
#Affichage du temps

echo -e "\033[4m
\

(pour éviter les 25 heures 78 minutes 112 secondes

\033[0m

| Le temps maximal total de calcul est de:
\ \033[33m${year}\033[0m année(s) \033[33m${day}\033[0m jour(s)

\033[33mS${hour}\033[0m heure (s)

\033[33mS${min}\033[0m minute (s)

\033[33mS${sec}\033[0m seconde (s)

\
\033[4m]|

\033[0m"

) #Fermeture de la fameuse parenthese
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Documentation Rainbow tables

Une table arc-en-ciel est un rassemblement astucieux de milliers (et millions !) de hash. Ces tables
permettent des recherches trés rapides de mots de passe, mais leur fonctionnement est complexe.

Fonction de réduction : processus qui va créer un mot de passe en texte clair a partir d’un hash présent
dans la table. Une fonction de réduction doit étre cohérente. C’est-a-dire qu’elle doit retourner le méme
mot de passe quand on lui donne le méme hash (empreinte).

Fonctionnement de la création d’une rainbow Table :

Hache (ou créé une empreinte) un mot de passe généré par 1’algorithme de création de table, applique
une fonction de réduction sur ce hash, re-hache le mot de passe obtenu. Ce processus s’effectue autant
de fois que «chain len », en utilisant une fonction de réduction différente a chaque fois. Une
rainbow table ne stockera que le mot initial, et le hash final. Cela permet d’obtenir une grande
quantité de mots contenus dans une quantité réduite de hash, et d’éviter de calculer toutes les valeurs
de toute la table (voir fonctionnement d’une recherche).

Probléme : les fonctions de réduction produisent des collisions, ¢’est-a-dire la présence de 2 chaines
identiques, car il y a plus souvent de mots de passe possibles que de hash. Mais les rainbow table
résolvent ce probléme en utilisant différentes fonctions de réductions. En plus de ce procédé, un
« postprocessing » final peut permettre de supprimer chaines dupliquées.

Plus la taille des chaines (chain len) est grande, plus la génération sera longue, mais le nombre de
mots de passe sera plus élevé.

Plus le nombre de chaine (chain num) est élevé, plus la taille de la table sera grande, mais le taux
de réussite lors d’une recherche sera plus élevé.

Fonctionnement de la recherche avec une rainbow table :

On test si le hash initial (dont on recherche le mot) correspond a un hash dit « final » (dans la derniere
colonne).

Si il est trouvé, la chaine correspondante contient notre mot de passe. Il faut donc recalculer la chaine
comme a la création de la table. On prend le mot de passe initial (celui en début de chaine), on le hache,
on test si le hash correspond a notre hash initial. Si oui, le mot de passe recherché est celui qui vient
d’étre hashé. Si non, on réduit le hash avec la 1¥® fonction de réduction, on hache la réduction, et on
re-test I’égalité avec notre hash. Ainsi de suite jusqu’a trouver notre hash, en changeant de fonction de
réduction a chaque étape.

Si on ne parvient pas a trouver le hash dés le départ, on le réduit avec la derniére fonction de réduction,
et on recherche le mot obtenu dans la 1°® colonne de la table. Si le mot n’est pas présent, on le hash, et
le réduit avec I’avant derniére fonction de réduction (on recule pour faire simple).

Générer une rainbow table :
rtgen [hash algo] [charset] [plaintext len min] [plaintext len max]
[table index] [chain len] [chain max] [part index]

Options:
hash algorithm :Un seul algorithme de hachage par rainbow table.
charset : définition d’un ensemble de caractéres (maj., min, chiffres,...).

plaintext len min  } Limites de la taille des mots de passe a générer.
plaintext len min }

table index : Sélection de la fonction de réduction (de 0 & 5).
chain len : Taille des rainbow chain.

chain num : Nombre de rainbow chain

part index . Indicateur de fin de table
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Exemple avec du MD5 et des mots de passe numérique (chiffre de 0 a 9) entre 1 et 4 caracteres :

./rtgen md5 numeric 1 4 0 3800 8000000 O
./rtgen md5 numeric 1 4 1 3800 8000000 O
./rtgen md5 numeric 1 4 2 3800 8000000 O
./rtgen md5 numeric 1 4 3 3800 8000000 O
./rtgen md5 numeric 1 4 4 3800 8000000 O
./rtgen md5 numeric 1 4 5 3800 8000000 O

Apreés la génération de table avec différentes fonction de réduction, il faut les « ranger »:

./rtsort *.rt

rtsort va ranger les rainbow chains de chaque tables par point d’arrivé pour permettre la recherche
binaire. Cette recherche compare la valeur centrale d’une liste de chaines rangées (par ordre
numérique/aplhabétique...) avec la valeur initiale. Si elles sont différentes, la moitié qui correspond a
la valeur subit le méme principe : sélection de la valeur centrale, comparaison. ..

Il faut mettre les tables de mémes algo de hash dans un méme dossier !
Taille d’une table (en octets)= chain_len*16

Exemple de crackage :

./rcrack [table directory] -1 [hashes file]
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